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1.0 Workforce Planning Background 
 

In 2017, the Virginia General Assembly created a legislative mandate (§ 2.2-1209. Agency 

director human resource training and agency succession planning) which requires the director of 

each agency in the executive branch of state government include in the agency’s annual strategic 

plan its key workforce planning issues. DHRM’s charge is to establish guidelines for the content 

of such workforce and succession plans.  

Since then, DHRM has provided various tools and an Excel based Workforce Planning and 

Development report template to guide agencies on what workforce planning information to 

evaluate and include.  

In 2022, DHRM has focused on realigning the strategy to workforce planning that incorporates a 

more holistic approach and focuses on the areas of continuity of operations, recruitment, 

retention/engagement, and workforce development. DHRM is developing tools and templates 

using a modular design approach, which enables DHRM to build a suite of integrated and 

customizable workforce planning tools for agencies.  

 

 

  

https://law.lis.virginia.gov/vacode/title2.2/chapter12/section2.2-1209/
https://law.lis.virginia.gov/vacode/title2.2/chapter12/section2.2-1209/
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2.0 Identifying Critical Roles Tool  
 

As part of the modular design approach, DHRM has created an Identifying Critical Roles Tool, 

which assists agencies with building a custom assessment, collecting data on specific positions, 

and summarizing assessment findings.  

The tool is designed to be flexible to meet agency’s needs, in both how positions are assessed 

and how data is collected. Agencies can choose specific questions in the areas of vacancy risk, 

recruitment, knowledge management, learning and development, operational impact, impact to 

strategic objectives, impact from the environment, position specific questions, and any additional 

questions.  

Agencies can also choose if the assessment is to be completed by others or by the individual 

using the tool. If completed by others, the tool is able to serve as a tracker for those distributed 

and returned.  

Though it is based in Microsoft Excel, it is not designed as a traditional workbook or worksheet. 

The tool is organized by grouping key information on various tabs, indicated at the bottom of the 

tool, which builds upon previous tabs.  

• Home - The Home tab is a central place for users to navigate to the different tabs, track 

their progress of each step, and to see what version of the tool is being used. 

• Getting Started – The Getting Started tab reviews important features, setup, and 

instructions for using this tool to its full potential. It is highly encouraged for users to 

review this tab. 

• Build Assessment – The Build Assessment Tab provides a list of questions to be include 

in a custom critical roles assessment for varying areas of criticality and the assessment 

parameters for identifying critical roles. Custom questions and parameters can also be 

identified on the build assessment tab. 

• Data Collection – The Data Collection Tab provides instructions for two pathways to 

collect data: either individually be the user of the tool or from others. The tab identifies 

which positions are assessed and serves as a tracker if data is collected from others.  

• Full Assessment – The Full Assessment Tab is the assessment that is either used to enter 

data or be shared with others.  

• Critical Roles Summary – The Critical Roles Summary Tab provides a brief workforce 

insights summary of the critical roles assessments, with options to filter by positions and 

criticality. Additional filters can be identified on the Data Collection tab.  

The tool also uses a series of Excel Macros, specific procedures that can automate processes, to 

increase the tool’s functionality and ease of use. Macros must be enabled in order to use these 

functions. However, the tool is also designed so that it can be used without Marcos if an agency 

wishes, but would requires some manually steps when completing specific sections. More 

information on the design on the tool are reviewed in the “Getting Started Tab” section. 
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3.0 Workforce Planning Data Definitions 
 

To promote alignment, definitions for specific data metrics are outlined in the Workforce 

Planning Data Definitions document on the DHRM Website.  

The Identifying Critical Roles tool includes data elements defined in both the General 

Definitions and Identifying Critical Roles Tool sections of the data definitions document. 

Please review the data definitions document for specific definitions as needed.  

 

 

 

 

 

 

  

https://www.dhrm.virginia.gov/docs/default-source/succession-planning/key-terms.pdf?sfvrsn=2
https://www.dhrm.virginia.gov/docs/default-source/succession-planning/key-terms.pdf?sfvrsn=2
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4.0 Tab Guides 
 

The Identifying Critical Roles tool is divided into several tabs that house similar information. It 

is recommended for users to progress through the tabs from left to right, beginning with the 

Home Tab. 

Home Tab 
The Home tab is a central place for users to see a description of and navigate to the different 

tabs, track their progress of each step, and to see what version of the tool is being used. The 

version number is located in the bottom right corner of the home tab, and is represented by the  

icon. 

Each of the tab names, highlighted in blue, are hyperlinks to the tabs. Click on any of the names 

to navigate to the respective tab. 

To being using the tool, click on the “Getting Started” Tab name in blue.  

 

Getting Started Tab 
The Getting Started tab reviews important features, overall setup, and some instructions on how 

to begin using the Identifying Critical Roles tool. Though it is not required to review, it is highly 

recommended users spend time to review this information.  

The tab begins with a quick overview and description of the contents.  

Blue Name of 

the Tab is a 

Link to the 

Respective Tab 

Progress bar Shows 

Step Completion 

Version 

Number of the 

Template 
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Step 1: Review Overall Setup 

The Getting Started tab provides a breakdown of the overall setup for the remaining tabs. Each 

tab follows the general setup of having the step number and title on the left hand side, a set of 

instructions underneath, and the required data to be entered labeled (either above or to the left).  

 

 

Cells with a yellow background indicate required information to be entered and cells with a 

green background are optional. Once all the required information is entered, the step indicator 

will change from Incomplete to Complete. 

Some steps may include sub steps, indicated by the step number and letters slightly indented 

from the left.  

 

Step 2: Review Important Features of This Tool 

The Getting Started tab provides a breakdown of the important features of the tool, used to assist 

with entering and interpreting workforce information. Below are descriptions of the tool’s key 

features.   

 

 

 

 

USE OF EXCEL MACROS 
 

This tool utilizes a series of Excel macros, which are custom actions 

used to automate specific tasks. This tool performs best when using 

Excel 2016 or later. NOTE: Excel Macros must be enable to use 

them. The tool can also be used without the Macros, but will require 

some manual edits. 
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EASY FILE NAVIGATION 
 

Each Excel Worksheet, or tab, houses related information which is 

compiled together into a single report. Links to each tab are frozen 

at the top of each tab to easily navigate between them. 

 

 

 

 

 

 

 

COLOR CODED DATA ENTRY 
 

Colors are used to identify what data should be entered and where. 

Yellow indicates required information. Green indicates optional 

information, and Gray indicates information is not required. 

 

 

 

 

 

BUILT-IN HELP FEATURES 
 

This tool has a built in help feature. Click on the question mark in 

the blue circle to open a window with additional information, 

definitions, and steps to complete. NOTE: Macros must be 

enabled. The tool cannot be edited while help windows are open. 

 

 

 

 

 

 

PROGRESS INDICATORS 
 

The home tab provides progress indicators for each step of the tool. 

Each tab also provides progress indicators for each step or sub-step, 

which show if the step is complete or incomplete. 

 

 

 

 

 

 

DATA IMPORT 
 

This tool is part of a suite of integrated workforce planning and 

development tools. Using these tools allows for information to 

easily be imported from one tool to the next. Data cannot be 

imported unless using a specific tool, provided by DHRM upon 

request. NOTE: MACROS MUST BE ENABLED TO UTILIZE 

THIS FEATURE. 

 

 

 

 

 

 

TOOL VERSIONS 
 

As we continue to enhance this tool, integrate it with other elements 

of workforce planning and development, or as changes to any 

mandates or guidance occurs, new versions of this tool may be 

released. The version number is located on the Home tab in the 

bottom right corner.  

 

It is important to be using the most up to date version, which will be 

noted on the DHRM Workforce Planning Website. As new versions 

are released, the prior version data can be imported so no progress is 

lost.  
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INCREASING LEVELS OF ANALYSIS 
 

To better assist with navigating the landscape of workforce planning 

and development, the suite of integrated tools and tools provide 

indicators for three levels of analysis: foundational, in-depth, and 

comprehensive. These levels are used to better identify why 

information is collected and how it can be used throughout the tools 

and tools. 

 

All foundational level elements are required and both the in-depth 

and comprehensive elements are highly encouraged, but optional. 
 

(Optional) Step 3: Enable Macros to Utilize Full Functionality 

To ensure Macros are enabled, when first opening the file or anytime the filename changes, you 

will see a “Security Warning” at the top (shown in the picture below) indicating Macros have 

been disabled. Click the “Enable Content” button to enable macros for the file. 

 

 

 

(Optional) Step 4: Import Data from Other Sources 

For efficiency and integration to other workforce planning and development tools, data from 

other sources can be imported. Imported data, shown in the table below, will automatically enter 

the information into the respective cells. Agencies are encouraged to still review the information 

for accuracy. 

Data Source Data Imported 
Identifying Critical Roles (Prior Version) All Previously Entered Data 

Identifying Critical RolesTemplate Agency Name 

Agency Mission 

Strategic Objectives 

Identifying Critical Roles Tool                         

(Assessment Settings Only) 

*Used when assessing more than 100 positions* 

All Settings (selected questions and parameters) 

Data Collection Process 

Identifying Critical Roles Tool                       

(Assessment Data Only) 

*Used to combine multiple tools together for a 

complete summary of Agency Critical Roles* 

Data Table from Critical Roles Summary Only 

 

The example below is how to import data from a prior Identifying Critical Roles tool, 

however, the process is the same for all data import options.  

To import the data, click on the Import Data Icon  for the tool the data is imported from (such 

as a previous version of the Identifying Critical Roles tool).  

 

Click to Enable Macros 
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This will open the standard “Open File” dialog box. Simply locate and select the previous 

version Identifying Critical Roles tool and click “Open”. (Shown in the picture below).  

 

 

 

 

 

 

 

 

 

 

 

If the data is imported successfully, the tool will indicate the date and time the data was imported 

(shown in the picture below).  

 

If the data import was unsuccessful, the dialog box (in the picture below) will indicate an error 

occurred and to contact DHRM Workforce Planning at dhrm.wfp@dhrm.virginia.gov.  

 

The same process is used to import data from the other sources (Agency Profile, Identifying 

Critical Roles Assessment Settings Only and Identifying Critical Roles Assessment Data Only). 

 

1. Select Prior Version Identifying Critical Roles 

Tool 

2. Click Open 

mailto:dhrm.wfp@dhrm.virginia.gov
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Build Assessment Tab 
The Build Assessment tab provides a list of questions to be included in a custom critical roles 

assessment and the threshold for determining role criticality. The assessment focuses on the areas 

of vacancy risk, recruitment, knowledge management, learning and development, operational 

impact, impact to strategic initiatives, impact from the environment, position specific elements, 

and custom questions.  

 

Step 1: Enter Agency Information 

To complete step one, entering agency information, select the agency name from the drop down 

menu in the yellow box and enter a brief description of the agency mission (shown in the picture 

below). To show the dropdown arrow, click in the yellow cell. The secretariat and agency 

number will be displayed automatically. If importing data from the Agency Profile, this 

information should automatically be entered and verified it is accurate. 

 

 

 

 

 

 

 

 

Step 2: Identify Questions to be Included in the Critical Roles Assessment 

To complete step two, indicate which questions should be included in the critical roles full 

assessment by selecting either “yes” or “no” from the drop down for the specific questions. All 

yellow boxes indicate questions that are required to have a response and the green boxes are 

those that are optional to include.  

 

 

 

 

 

 

 

1. Click on Arrow 

to See Dropdown. 

2. Select Agency 

from Dropdown.  

Enter Agency 

Mission 

Click for 

Help if 

needed 

1. Select either 

“Yes” or “No” from 

the dropdown for 

each question. 
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This process is repeated for each required question (noted with the yellow box) of the following 

steps:  

• Step 2(a): Select Vacancy Risk Questions 

• Step 2(b): Select Recruitment Questions 

• Step 2(c): Select Knowledge Management Questions 

• Step 2(d): Select Learning and Development Questions 

• Step 2(e): Select Operational Impact Questions 

• Step 2(f): Select Strategic Objectives Impact Questions (see below for optional step 

instructions) 

• Step 2(g): Select Environment Questions 

• Step 2(h): Select Position Specific Questions 

 

(Optional) Step 2(f-i): Select Specific Strategic Plan Initiatives from Agency Profile 

Positions can be assessed for their impact to specific strategic plan objectives and action items 

from the Agency Profile. To include the specific objective or action item, select the objective 

and/or action items and indicate if they should be included by selecting “Yes” or “No” from the 

dropdown menu.  

 

 

 

 

 

 

 

 

On the assessment, the question will be phrased as “What is the degree the agency would 

experience challenges in achieving the following strategic objectives and action items:” 

 

(Optional) Step 2(f-ii): Add Strategic Objectives or Action Items if not Using Macros 

If the strategic objectives and action items were imported from the Agency Profile or if this 

information is not going to be included, this step can be skipped. 

In the event Macros are not being used and agencies want to include this information in the 

assessment, first enter the total number of objectives and the number of actions for each 

objective in the green boxes.  

1. Select either 

“Yes” or “No” from 

the dropdown for 

each objective or 

action item. 
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After the numbers are entered, click on the Filter Icon in cell W1 to show the filter menu (top 

right corner). Ensure there is no check box next to “0” (zero) and then click okay to filter the 

sheet.  

 

1. Enter the 

Total Number 

of Objectives 

2. Enter the 

Total Number 

of Action Items 

for Each 

Objective 

NOTE: If there is no objective, 

the box will be grayed out and 

can be left empty 
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Scroll up on the sheet to see the entry boxes for all objective and action items. Enter the 

objective and action items and then indicate if they are to be included in the assessment by 

selecting “yes” or “no” from the dropdown menu. The objective and action item numbers can be 

changed using this same process. If the objective number decreases, ensure all grayed out cells 

for the action items are empty, otherwise the data will not filter correctly. 

 

(Optional) Step 2(i): Add Additional Questions 

If no additional questions are going to be added, this step can be skipped. 

To add additional questions, click the blue “Add Question” button to show the entry boxes 

(shown in the picture below). Up to 10 additional questions can be added. 

 

3. Click the filter 

Icon to show 

filter menu 

4. Verify “0” 

is unchecked 

5. Click Ok 



16 
 

 

 

 

 

 

 

 

 

 

Scale Type Breakdown:  

 

Questions can be removed by clicking the blue “Remove Last Question” button. This will 

remove the last question added. 

 

 

 

 

 

 

 

(Optional) Step 2(i-i): Add Additional Questions if not using Macros 

If the blue buttons were used to add additional questions or if no additional questions are 

going to be added, the step can be skipped. 

In the event Macros are not being used and agencies want to include additional questions in the 

assessment, first enter the total number of questions in the green box.  

1. Click the “Add Question” button again to 

add up to 10 Questions. 

2. Enter the Question 

in the Green box 

3. Select Scale Type from 

Dropdown (see below) 

Click to Remove 

Last Added 

Question 
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After the number is entered, click on the Filter Icon in cell W1 to show the filter menu (top right 

corner). Ensure there is no check box next to “0” (zero) and then click okay to filter the sheet.  

  

 

 

  

 

 

 

 

 

 

 

 

 

Scroll up on the sheet to see the entry boxes for the additional questions. Enter the question and 

select the scale type for each.  

 

(Optional) Step 2(i-ii): Create an Additional Scale 

If none of additional questions scale types were selected to be “Other”, this step can be 

skipped. 

To create an additional scale for additional questions, first ensure the scale type for the question 

is “Other”. Next, enter the descriptive labels for each level (1-6) of the additional scale in the 

green boxes below.  

1. Enter the 

Total Number 

of Questions 

2. Click the filter 

Icon to show 

filter menu 

3. Verify “0” 

is unchecked 

4. Click Ok 
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(Optional) Step 3: Add Closing Remarks or Additional Instructions 

In the event the agency would like to communicate any specific instructions, next steps, or other 

remarks on the assessment, enter the information in the green box (shown in the picture below). 

If data is to be collected from others, it is encouraged this section be completed.   

 

 

Step 4: Set Assessment Parameters 

The assessments generates a score for each area of the assessment by adding the question scores 

together and an overall assessment score by adding the scores for each area together (shown in 

the graphic below). 

 

Step 4(a): Identify Overall Minimum Score for Critical Roles 

To identify if a role is critical or not, agencies are required to enter the minimum score that must 

be reached for a role to be identified as critical by entering the score into the yellow box (shown 

below). The potential maximum score based on the questions selected/added is also provided to 

assist agencies in determining the threshold.  

 

 

1. Enter 

remarks in 

green box. 

1. Enter labels for 

each scale level 
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(Optional) Step 4(a-i): Identify Criticality by Category 

In addition to the minimum overall score, Agencies have the ability to indicate the minimum 

score for each area. Criticality can be determined in the overall score “and” category score are 

met or if the overall score “or” the category score are met.  

Only the categories the agency wishes to include in determining criticality need to have the 

information entered. If not, the boxes can be left blank. 

To identify criticality by category, select either “and” or “or” from the dropdown to indicate the 

relation to the overall score and then enter the minimum score for the category. The potential 

maximum score based on the questions selected/added is also provided for each category to 

assist agencies in determining the threshold. 

 

 

 

 

 

 

 

 

 

Step 5: Identify if the Assessment Results (Critical or Not Critical) should Appear on 

Assessment 

To indicate if the assessment results should appear on the assessment, select either “yes” or “no” 

from the dropdown menu for the yellow box (shown in the picture below).  

 

1. Enter the 

Minimum 

Overall Score 

1. Select either Yes or 

No from the 

dropdown 

2. Enter total 

minimum score 

for category 

1. Select Yes or 

No from 

Dropdown 

Menu 
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(Optional) Step 6: Check Spelling 

The tool allows for the spell check feature to be used on this tab, however, Macros must be 

enable to use this feature. Click the “Spell Check This Tab” purple button, which will launch the 

Excel spell check function.  

 

 

 

Step 7: Refresh the Assessment 

After selecting all questions and thresholds, the assessment will need to be refreshed. To refresh 

the full assessment, click the blue “Refresh Assessment” button.  

Before 

 

After 

 

If not using Macros, the assessment list can be refreshed by going to cell “AF1” on the FULL 

ASSESSMENT TAB and clicking the filter icon. After, ensure the “0” box is unchecked, click 

Ok.  

 

Data Collection Tab 
The Data Collection tab identifies the process to be used for collecting data (either individually 

or data from others). If collecting data from others, this tab identifies what positions will be 

assessed, their working title, who the assessor will be, and assists with tracking which 

assessments have been created and returned.  

If collecting the data individually (the individual using this tool), the tab identifies the steps to 

begin complete the assessment for positions.  

1. Click Spell Check This Tab button to 

launch the Check Spelling function 
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Step 1: Identify Data Collection Process 

Identify the desired data collection process by selecting either “self” or “from others” from the 

dropdown meu in the yellow box (shown in the picture below).   

 

 

If “From Others” is chosen, additional instructions will be displayed to refresh the report, if 

needed, and to proceed to step 2.  

 

If “self” is chosen, additional instructions will be displayed to refresh the report, if needed, and 

to proceed to step 4.  

 

 

If not using Macros, the assessment list can be refreshed by going to cell “AF1” on the FULL 

ASSESSMENT TAB and clicking the filter icon. After, ensure the “0” box is unchecked, click 

Ok.  

 

Step 2: Add Positions to Be Assessed 

Add positions to be assessed by clicking the blue “Add Position” button to add the position 

number, working title, and assessor name in the yellow boxes (shown in the picture below). Up 

to 100 positions can be added per critical roles tool.  

1. Select 

Process from 

Dropdown 

Menu 

Click for 

Help if 

needed 
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Positions can be removed by clicking the blue “Remove Last Position” button. This will remove 

the last position added. 

 

 

 

 

 

 

 

(Optional) Step 2(a): Enter Positions to Assess if not using Macros 

If the blue buttons were used to add additional positions, this step can be skipped. 

In the event Macros are not being used, first enter the total number of positions being assessed in 

the green box.  

 

 

 

 

 

After the number is entered, click on the Filter Icon in cell W1 to show the filter menu (top right 

corner). Ensure there is no check box next to “0” (zero) and then click okay to filter the sheet.  

1. Click the “Add Position” button to add up to 

100 positions. 

2. Enter Position 

Number 

3. Enter 

Working Title 

4. Enter 

Assessor Name 

Click to Remove 

Last Added 

Position 

1. Enter the 

Total Number 

of Positions 
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Scroll up on the sheet to see the entry boxes for the additional questions. Enter the question and 

select the scale type for each.  

 

(Optional) Step 2(b): Add Additional Filter Criteria by Position for Critical Role Summary 

If additional filters would like to be added, such as internal departments, sub-agencies or 

divisions, lines of service, locations, EEO Code, or Employee Classification from the Agency 

Profile. To enter the additional filter for a position being assessed, enter the respective filter for 

the position in the green boxes for the respective column. Filters not being included can be left 

blank.  

 

 

 

 

2. Click the filter 

Icon to show 

filter menu 

3. Verify 

“0” is 

unchecked 

4. Click Ok 

1. Enter Filters in the 

Respective Columns 
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Step 3: Create Assessments to be Shared with Others 

After adding positions, assessments can be created to be shared with others. First select the name 

of the assessor from the drop down menu and enter the date the assessment is being created, then 

click the Create Assessment(s) button.  

 

 

 

The Create Assessment(s) button will open a new excel workbook with all the assessments for 

the assessor on different tabs. The tab names will be changed to the position number of the 

position being assessed. Note: It is recommended all other excel workbooks are closed before 

creating assessments. The screen will flash the same amount of assessments being created.  

The date the assessment is created will automatically be entered into the “generated” column in 

the position list (shown below). 

 

 

(Optional) Step 3(a): Create Assessments if not Using Macros 

If chosen not to use Macros, go to the Full Assessment Tab and enter the position number, 

working title, assessor name, and assessment date at the top of the assessment. On the bottom of 

the screen where each tab is located, RIGHT click on the “full assessment” tab and select “Move 

or copy”. In the “to book” at the top of the dialog box, select “(new book)” from the dropdown 

and click “create a copy”. Click Ok to create a new workbook with the assessment. The 

workbook can then be saved normally and sent to the individual to complete.  

To create a batch of assessments for a single assessor without Macros, simply choose the same 

workbook as other assessments (instead of “new book”) when identifying the workbook to copy 

the assessment too. This will add another tab within that workbook. 

 

3. Click create 

assessment(s) 

button. 

1. Select 

Assessor Name 

2. Enter 

Assessment 

Date 
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Step 4: Import Assessments Data and Track Completions from Assessments Shared 

When completed assessments are returned the data can be imported directly into the tool by 

clicking the Import Data Icon and selecting the assessments to import (multiple files can be 

selected).  

To import the data, click on the Import Data Icon  for the tool the data is imported from (such 

as a previous version of the Agency Profile).  

 

 

 

 

 

 

 

 

 

 

 

 

This will automatically add the data to the Critical Roles Summary data table and the date to the 

position list from Step 2.  

 

 

(Optional) Step 4(a): Enter Assessment Data if Not Using Macros 

If the data import process was used to add data, this step can be skipped. 

If chosen not to use macros, the data from each assessment will need to be copied and pasted into 

this tool individually. On the assessment, unhide the columns “Q” through “Y” by selecting 

columns P and Z. RIGHT click and select “unhide” to show the calculation columns. In Column 

1. Select Assessments to be imported. 

3. Click Open 



26 
 

Y, a series of cells are highlight yellow with the position information and scores. Highlight all of 

the yellow cells (Y7-Y73) and copy the data.  

On the “Critical Roles Summary” Tab, at the bottom is a data table, outside of the critical roles 

summary border. In the next blank row in the table, RIGHT click on the cell on the second 

column (position number), go to the arrow next to “paste special” and select “paste special…” 

text at the bottom. Select “Values” and “Transpose” and click okay. This will paste the values 

from the assessment and show the data horizontally instead of vertically. The data will then show 

on the Critical Roles Summary.  

 

Step 5: Collect Data without Sharing the Full Assessment 

If the data was collected from others, this step can be skipped. 

If not sharing the assessment, go to the Full Assessment Tab and enter the position information 

(title, position number, assessor and date) at the top of the assessment. Complete the assessment 

for the position.  

 

 

After, click the blue “Submit Assessment” button at the bottom to enter the information and clear 

the assessment.   

 

 

 

(Optional) Step 5(a): Collect Data without Sharing the Full Assessment if Not Using 

Macros 

If the data was collected from others, this step can be skipped. 

If chosen not to use Macros and to collect data without sharing, complete the assessment using 

the same steps as descripted in step 5. Instead of clicking the blue “submit assessment” at the 

end, unhide the columns “Q” through “Y” by selecting columns P and Z. RIGHT click and select 

“unhide” to show the calculation columns. In Column Y, a series of cells are highlight yellow 

with the position information and scores. Highlight all of the yellow cells (Y7-Y73) and copy the 

data.  

1. Enter the 

Position 

Information 

2. Click top submit 

assessment. 
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On the “Critical Roles Summary” Tab, at the bottom is a data table, outside of the critical roles 

summary border. In the next blank row in the table, RIGHT click on the cell on the second 

column (position number), go to the arrow next to “paste special” and select “paste special…” 

text at the bottom. Select “Values” and “Transpose” and click okay. This will paste the values 

from the assessment and show the data horizontally instead of vertically. The data will then show 

on the Critical Roles Summary.  

On the “Full Assessment” Tab, the columns “Q” through “Y” can be hidden again or left visible, 

depending on the preference of the user. The data will need to manually be cleared or adjusted 

for any additional assessments to be completed. Repeat this process for any additional 

assessments. 

 

Critical Roles Summary 
The Critical Roles Summary provides a brief review of the data submitted using the critical roles 

assessments, by identifying the percentage of positions assessed that were identified as critical 

(based on criteria from the Build Assessment Tab) and a breakdown of the number of positions 

and average score for each area. Data can also be filtered based on the filters entered in the Data 

Collection tab.  

Before reviewing the Critical Roles Summary, the summary will need to be refreshed. To refresh 

the summary, click the blue “Refresh Summary” button.  

 

Before 

 

After 

 

If not using Macros, the employee classification list can be refreshed by going to cell “AA1” and 

clicking the filter icon. After, ensure the “0” box is unchecked, click Ok.  

In the event the additional filters were added (department, division, line of service, location, EEO 

Code, classification), they can be shown by clicking the blue “Show/Hide Additional Filters” 

button. The button can be clicked again to hide the additional filters. 
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(Optional) Step 2: Export the Summary to PDF 

By default, the date of the summary is the current date. However, if the summary should reflect a 

different date, a new date can be entered in the green box (shown below).  

 

The summary can be exported as a PDF by clicking the “Export Workforce Insights to PDF” 

blue button. This will open a dialog box to save the PDF using the standard process to save a file. 

The report can be viewed by going to the saved location and opening the file.  

 

(Optional) Step 2(a): Printing the Summary to PDF (without Macros) 

If not using the Macros, the report can be printed as a PDF using the standard Excel print 

function. Go to the “File” menu, and select print. Ensure the printer is “Microsoft Print to PDF” 

and click “Print”. Choose the save location and click “Save”. The report can be viewed by going 

to the saved location and opening the file. 

 

(Optional) Step 3: Remove Submitted Assessment Data 

In the event submitted assessment data needs to be removed, go to the row number of the 

assessment data to be removed (first column of the table) and click on the cell with the correct 

row number. Right click and go to “Delete” and then “Table Rows”. If the assessment data needs 

to be reentered, complete another assessment. 

 

 

 

 

 

 

 

 

 

1. Enter new 

date if needed.  



29 
 

4.0 Next Steps 
 

The Identifying Critical Roles can be imported directly into other Workforce Planning Tools and 

Tools (examples below). This will automatically populate certain information into those tools, 

based on the purpose and design of each tool.   

 

 

 

 

For Questions or Additional Assistance 

For questions or assistance with the tool, please contact DHRM Workforce Planning at 

dhrm.wfp@dhrm.virginia.gov.  

 

 

 

mailto:dhrm.wfp@dhrm.virginia.gov

